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Construct realistic 3D view of a scene 

Time: 1 hour, 30 minutes 

Overview  

Many 3D scenes are reconstructions of elements in the physical world, such as parks, cities, and 

geological strata. These scenes rely heavily on 3D vector symbology, in which the elements are shown 

using realistic shapes and sizes. These layers are listed in the 3D Layers category in the Contents pane.  

Realistic 3D vector symbology is defined using real-world size units, such as meters or feet, rather than 

the traditional 2D cartographic unit of points. The features can obtain their base elevations from a 

surface, stored shape z-values, feature attributes, or from a constant value. Although vector data can be 

more expensive to render than draped data, it adds 3D volumetric shapes into the view and is usually 

the focal point of the scene. By default, 3D (z-aware) points, lines, polygons, multipatches, and scene 

layers are added to the scene under the 3D Layers section.  

In this lesson, you will be working with simple GIS data for the city of Naperville. This includes building 

footprints, city-managed trees, street furniture, and points of interest that will be used to create a 

realistic 3D view. You will also consider how the scene might be consumed by others. 

In this lesson, you will learn to do the following: 

• Extrude building footprints as simple 3D symbology 

• Use procedural symbols for advanced 3D symbology 

• Add a preset trees layer with per-feature height 

• Add street furniture content with per-feature rotation  

• Add bookmarks to help users find their way around the scene 

Open map package 

First, download the data. Then create a project in ArcGIS Pro. 

1. Download the Naperville.zip compressed folder. 

2. Locate the downloaded file on your computer and extract it to a location you can easily find, 

such as your Documents folder. 

 

https://downloads.esri.com/learnarcgis/3d/naperville.zip
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The data has been provided by the City of Naperville. The folder contains a map package, a scene layer 

package, and a file geodatabase. 

You will now create a project using the Blank Project template. 

1. Start ArcGIS Pro and create an ArcGIS project, based on the Blank project template  

 

 

Note: If you don't have ArcGIS Pro or an ArcGIS account, you can sign up for an ArcGIS free trial. 

2. On the Quick Access toolbar, press Save  or press Ctrl+S to save your project. 

3. In the Save Project As window, name your project 'CityofNaperville' and browse to your 

Naperville.zip folder. 

4. On the Insert tab, in the Project group, click Import Map . 

5. Browse and select Vector_Content_Naperville.mpkx from your extracted data location. 

http://links.esri.com/arcgis-free-trial/
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6. Click OK.  

The Vector_Content_Naperville.mpkx file contains a global scene for the city of Naperville. Notice that 

the Contents pane contains a 2D BuildingFootprints layer as well as the 3D layers:  StreetFurniture and 

BuildingShells. 

Extrude building footprints 

One of the simplest methods for adding volumetric objects into a 3D view is extrusion. This method 

takes a 2D shape and pushes it vertically to create the appearance of a 3D object. Simple buildings are 

well-suited for this method because they have vertical walls and their individual heights can be captured 

(or estimated) in a simple numeric field. 

1. In the Contents pane, locate 2D Layers, right-click BuildingFootprints, then choose Attribute 

Table. 
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2. In the BuildingFootprints attribute table, review the Base Elevation, Building Height, and 

Number of Floors fields.  

These fields can be used to set the base elevation for buildings and for extrusion of the building 

features. 
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3. When you are done reviewing the BuildingFootprints attribute table, close the table. 

Before you can apply 3D vector symbology to the BuldingFootprints layer, you will move the layer into 

the 3D Layers group. 

4. In the Contents pane, click-and-drag the BuildingFootprints layer into the 3D Layers category. 

 

The layer looks like it is fragmented and bumpy because the vertices of each polygon are being placed 

on the uneven surface, and their interiors are being calculated unevenly across it.  

 



Construct realistic 3D view of a scene 
If the elevation of each building footprint is set to a single value, they will appear flat. 

5. In the Contents pane, right-click the BuildingFootprints layer and select Properties. 

6. In the Layer Properties pane, click the Elevation tab. 

7. Set Features to At an absolute height. 

 

 
 

8. Click the A field option, then select BASEELEVAT from the field drop-down list. 

 

 
 

9. Click OK. 

The building footprints display with flat interiors and are rendered at their correct base elevation. 
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Next, you will extrude each of the buildings up to their building height. 

10. In the Contents pane, select the BuildingFootprints layer. 

11. On the ribbon, click the Appearance tab. 

12. In the Extrusion group, click the Type drop-down arrow and choose Base Height. 

 

13. In the Field control, choose the Building Height field. 
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The 2D building polygon layer is displayed as 3D shapes. 

 

Tip: If you are working with data that doesn’t have a dedicated height field, you might be able to 

estimate building heights using an expression  - such as “NumberOfFloors * 3.5”.  

Using procedural symbology 

Extrusion helps visualize the real-world space consumed by buildings, but it doesn’t show other useful 

information, such as the number of floors for each building. This could be important for first responders 

and city planners. We can replace the solid color display with a different kind of symbol–a procedural 

symbol–to incorporate additional information into the display. 
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A procedural symbol is a script that can construct additional geometry, colors and textures from a 

source feature’s geometry, and then apply that as a symbol within the scene. You can build your own 

procedural symbols using Esri CityEngine, or simply use one that comes with an Esri product or solution.  

1. In the Contents pane, select the BuildingFootprints layer. 

2. In the Extrusion group, click the Type drop-down arrow and choose None. 

3. In the Contents pane, right-click the BuildingFootprints layer and click Symbology. 

4. In the Symbology pane, click the symbol for the layer to modify it. 

 

 
 

5. In the Format Polygon Symbol gallery, type “stack” in the search field and select All styles from 

the drop-down menu next to the search field. 
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6. From the results, click the Stacked Blocks symbol to assign it to the layer. 

In the Contents pane, you will see the new Stacked Blocks procedural symbol appear under the 

BuildingFootprints layer, and in the map window, you will see the building polygons symbolized as 

stacked blocks. 

 

Next, you will configure the procedural symbol to connect to individual feature attributes. 

7. In the Format Polygon Symbol pane, click the Properties tab. 

 

 
 

8. Click the Layers subtab to configure the symbol. 

9. Change the Representation to Thin divider. 
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10. Change the Units to Feet. 

11. For TotalHeight, click the database icon and choose the BLDGHEIGHT field to set the building 

footprints extrusion height. 

 

 
 

12. Click OK in the Set Attribute Mapping dialog box to apply the choice. 

13. For Levels, click the database icon and choose the FLOORCOUNT field to set the number of 

levels for each building. 
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14. Click OK in the Set Attribute Mapping dialog box to apply the choice 

15. At the bottom of the Symbology pane, click Apply for the changes to take effect. 

 

Tip: Symbol properties with attribute mapping have a blue database icon. 
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Each building renders at its defined height, with striping that indicates the number of floors. These flat-

roofed buildings, sometimes referred to as level of detail (LOD) 1 buildings, provide content that support 

many 3D mapping needs.  

 

However, not all buildings have flat rooftops. To model pitched-roof forms, we need to move away from 

simple extruded shapes and into a more comprehensive way of modeling buildings. There are a variety 

of methods for creating this type of data–some of which will be covered in later sessions–but, for this 

exercise, we will assume the data is preexisting or has been compiled by a data provider.  

Note: Other Learn ArcGIS lessons are available, such as Extract Roof Forms for Municipal Development 

and Construct Realistic Buildings with Multipatch Editing for a lidar-centric roof extraction process. 

Let’s look at a building in which a flat-top roof isn’t effective. 

16. On the ribbon, on the Map tab, click Bookmarks, and click Pitched Roof. 

https://learn.arcgis.com/en/projects/extract-roof-forms-for-municipal-development/
https://learn.arcgis.com/en/projects/construct-realistic-buildings-with-multipatch-editing/
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The scene updates and zooms to a rectangular building. 

 
17. In the Map tab > Layer group, click Add Data.  Browse to your source data folder, select 

NapervilleLidar.slpk, and click OK. 

 



Construct realistic 3D view of a scene 

 

You may receive a notification about uncommitted symbology; click OK to proceed. 

 

18. In the Contents pane, right-click NapervilleLidar and click Symbology. 

19. In the Symbology pane, change the Symbol size property to 30%. 
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20. In the Contents pane, turn off the BuildingFootprints layer, and turn on the BuildingShells layer. 

 

The building footprints are simple 2D polygons that you have extruded based on a height attribute. 

The building shells are true 3D features and are multipatch features that have their 3D properties 

maintained as part of the geometry and do not require attributes to be extruded and rendered 

correctly in 3D space. The lidar points line up with the roof shape; the multipatch layer’s (LOD 2) 

buildings more closely match the real world. 

 

21. In the Contents pane, turn off the NapervilleLidar layer. 
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Using procedural texturing 

3D models are stored in the geodatabase as multipatch feature classes. A multipatch feature class is the 

same as other feature class types, like points and polygons, in that it contains per-feature geometry and 

per-feature attribute values. Additionally, it has specific options for how it can be symbolized.  

The exterior shell of a multipatch can be “painted” in a variety of ways. It might use imagery, like a 

photo taken from the street, or it might use a color, like its zoning code, or it might be procedurally 

generated and added in real time. We often refer to the exterior representation of a multipatch 

generically as its texture. This exercise will use procedural texturing to convert our flat-white buildings 

into something more useful. 

1. In the Contents pane, expand the BuildingShells layer, and click the symbol to open the 

Symbology pane. 
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2. At the top of the Format Mesh Symbol pane, click the Gallery tab. 

3. In the search text box, type “procedural” , make sure All styles is selected, and then press Enter. 

 

 
4. In the results, click Multipatch Facades. 

The multipatch draws with procedurally generated textures, using the symbol’s default settings. 
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5. In the Symbology pane, click the Properties tab, and then click the Layers subtab. 

 

 
 

6. For Units, click the database icon and verify that it is mapped to the Units field. 
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7. Click OK to apply the attribute mapping. Verify the Units value is set to Feet.  

8. For EaveHeight, click the database icon to map the property to the EAVEHEIGHT field and click 

OK. 

  
 

9. For Levels, click the database icon to map the property to the Floor Count field and click OK. 

 
Next, you will set the parameters for the vertical-wall stripe texture. 
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10. For FacadeTexture, choose Color from the drop-down list. 

 

11. For FacadeColor, choose a mid-gray, such as Gray 30%, from the color picker. 

 

 
 

12. Expand Options. 

13. Update the SeparatorPercentage value to 10%. 
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14. At the bottom of the Symbology pane, click the Apply button 

 

To enhance the appearance of your 3D city map, you may want to add some additional vector layers. 

Add street furniture 

Apart from buildings, another commonly managed feature in a city is street furniture, such as benches, 

light poles, and bus stops. These are important locational elements that residents will be aware of, and 

refer to, in most urban environments. For this exercise, we only have a small set of example features, 

but the technique remains the same, regardless of feature count. 

1. Turn on the StreetFurniture layer. 

2. In the Contents pane, right-click StreetFurniture, and click Zoom to Layer. 

3. Use the mouse’s wheel button to rotate the view to a more oblique view position. 



Construct realistic 3D view of a scene 

 
 

4. Use the right mouse button and drag to zoom in/out–pay attention to the size of the pushpin 

symbols. 

 

 

The points are being symbolized with a red billboarded pushpin that is in screenspace size.  

Screenspace-sized symbols render with a size based on the pixels on your screen. They are very effective 

for locational points because they are guaranteed to be seen at all viewing distances. However, they are 

not useful for representing real-world objects. 

Real-world-sized symbols, on the other hand, render with a consistent volumetric size. This is consistent 

with our day-to-day interaction with the world, where objects that are farther away appear smaller. Our 

street furniture data needs to use this rendering method. 
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5. In the Contents pane, right-click the StreetFurniture layer and click Properties. 

6. In Layer Properties, on the Display tab, check the Display 3D symbols in real-world units check 

box. 

 

 
 

7. Click OK to close Layer Properties. 

8. Use the right mouse button and drag to zoom in/out–pay attention to the size of the pushpin 

symbols. 
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Next, you will replace the pushpins with representative 3D models. 

The StreetFurniture data we are using for this exercise includes unique values to identify light poles and 

park benches. We will use these unique values in the data to create two classes. You can then apply a 

different 3D model symbol to each class. For your own data, you can use as many classes as you need. 

9. In the Contents pane, click and select the StreetFurniture layer. 

10. Click the ribbon, and open the Appearance tab. 

11. In the Drawing group, click the Symbology drop-down arrow and select Unique Values. 

 

12. In the Symbology pane, confirm TYPE is specified in Field 1. 
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13. Click the Add All Values button.  

 

 
 

14. Expand the More drop-down list and uncheck Show all other values. 

 

 
15. In the Symbology pane’s symbol list, click the symbol (left column) for the Light type to modify. 
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16. Select the Gallery tab and search for “light” in All styles. 

 

 
 

17. In the 3D Street Scene section of the results, select the Overhanging Street – Light off symbol. 

 

 

The scene updates and lights are now displayed with overhanging street lights symbols. 
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18. In the Contents pane, expand and click the symbol for the Park Bench type in the 

StreetFurniture layer. 

 

 

19. In the Symbology pane Gallery tab, search for “bench” in All styles. 

20. Select the Park Bench 2 symbol. 
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The points are now displayed with realistically sized models … but they are facing the wrong 

direction. 

 

Next, you will set attribute-driven rotation for the symbols. 

21. In the Symbology pane, click the menu button, and click Vary symbol by attribute. 
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22. Expand the Rotation group. 

23. For the Direction (Z) rotation property. apply the ROTATION field. 

 

 
 

24. Set the Rotation Style to Geographic. 

 

The light symbols are rotated to hang over the street, and the park benches now face each other. 



Construct realistic 3D view of a scene 
The rotation values were pre-calculated for this data. For your own content, you can manually enter 

values for a few features, or use geoprocessing tools against nearby streets for many features. 

Add trees 

Another primary element of most cities is vegetation and trees. You can use the same technique for tree 

point features as you did for street furniture–that is, create a set of unique classes and individually 

define each symbol–or you can use ArcGIS Pro’s built-in preset layer option. The Preset Layer gallery 

provides a streamlined way to add, and configure, common types of 3D content into the scene. 

The Thematic Trees option uses geometric forms, such as spheres and cones, to represent the tree 

shape. This display option fits better with this scene (rather than the Realistic option) because it 

matches the thematic styling of the current basemap and building features.   

1. On the ribbon, click the Map tab, in the Layer group, click the Add Preset gallery drop-down list. 

 
2. From the list, choose Thematic Trees. 

3. Browse to your home data folder and choose NapervilleAdditionalData.gdb > DS > TreePoints 

and click OK. 
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The tree layer’s HEIGHT field will automatically have populated because the field name matches the 

symbol property name. For color, each tree has a property for carbon accumulation that we can match 

to a color ramp. 

4. In the Symbology pane, set the Color By Value option to the Accumulation field. 

 

All symbology changes for preset layers are automatically applied, and the TreePoints layer, with the 

applicable height and accumulation color defined for each feature, is added to the scene.  
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Setting useful bookmarks 

The city scene is looking good, but it can be difficult to get to specific locations, especially if you are not 

familiar with the geography of Naperville. Bookmarks store important viewpoints in the scene, and can 

help users quickly zoom to key locations, or reorient themselves if they get lost. 

1. On the Map ribbon tab, expand the Bookmarks drop-down menu and click Manage Bookmarks. 

2. Navigate in the scene to get a ground-level view of the street furniture features. 

3. In the Bookmarks pane, click New Bookmark, set the name to Street Furniture and click OK. 

 

 

For this exercise, we used a bookmark for the pitched roof example. This is not important for future 

users of the scene, so let’s delete it. 

4. In the Bookmarks pane, click Manage Bookmarks. 

5. In the Bookmarks manager pane, hover over Pitched Roof and click the remove button . 
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Some cities have well-known landmarks or points of interest. It can be helpful to create bookmarks 

for these locations so users can get there quickly. Let’s create one for the local high school. 

6. On the Map tab, in the Inquiry group, click Locate. 

7. In the Locate pane, in the search text box, type “Naperville Central High” and press Enter. 

 

The search will locate the high school and zoom the view, so it is centered on the screen. 
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8. Right-click and drag on the high school to zoom in closer. 

 

 
 

9. In the Bookmarks pane, click New Bookmark, set the Bookmark Name to “Naperville HS” and 

click OK. 

 

This gives the user three bookmarks to access when navigating the view.  
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You can add as many as you like. If you were to share this scene to the web, the bookmarks would be 

automatically included as slides in the online scene viewer. 

10. Save your project and close ArcGIS Pro. 

Summary 

Many scenes are focused on modeling a realistically sized and shaped representation of the world for 

workflows such as visual impact, construction planning, and environmental impact studies. These scenes 

tend to use real-world-sized symbols that are tied to individual feature attributes, especially for 

properties such as rotation, width, and height.  

The use of thematic elements is still encouraged, though primarily through colors and textures that 

don’t impact the volumetric shape of the features. We used a color ramp for the trees’ carbon 

accumulation value, and we used procedural texturing on the buildings to differentiate the roof from 

the walls and indicate the number of floors. You also considered how users would interact with the 

scene by including bookmarks for a few key viewing positions.  
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